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Lighting and Rendering Tutorials

The tutorials in this section relate to different
lighting and rendering features that let you
produce outstanding images and animations with
3ds Max. You will learn how to use a variety of
lighting methods, how to render still images and
animation, and how to use three powerful features
in mental ray for achieving global illumination.

Files for This Section

All the files necessary for this tutorial are provided
on the program disc in the \tutorials directory.
Before starting the tutorials, copy the \tutorials
folder from the disc to your local program
installation.

Introduction to Lighting
Lights are objects that simulate real lights such as
household or office lamps, the light instruments
used in stage and film work, and the sun itself.
Adding lights to a scene can help give it a more
realistic appearance. If a scene contains geometry
but no light objects, 3ds Max provides default
lighting. But as soon as you add a light object to

the scene, the default lighting is turned off. Setting
up lighting is not difficult, but in order to do it well
you need to plan ahead and experiment.

How you set up lights for a scene, depends on the
purpose of your rendering or animation. Lighting
situations fall into two broad categories:

• Lighting a space; for example, an architectural
model.

Lighting an outdoor daylight scene is a special
case of this, because 3ds Max has special
features for daylight.

Lighting an interior space

• Lighting a specific subject; for example, a
talking head.

Lighting and Rendering
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Whether the subject is a character, a still life, or
other detail, the principles of lighting are much
the same.

Lighting a subject

Skill level: Beginner

Time to complete: 30 minutes

Tutorial Files

Note: All the files necessary to do the tutorials can
be found on the program disc. Before doing the
tutorials, copy the \tutorials directory from the
disc to your local program installation.

Lighting an Interior Space

To light an interior space, the guidelines are
simple: use light objects with realistic values, and
place them where you would in the actual building.
Photometric lights are preferred for this, but to use
photometric lights, it is essential that the model
have realistic dimensions.

Set up the scene:

• In the \tutorials\lights directory, open the file
interior_unfinished.max.

The scene shows an interior living-room space,
with a fireplace and entrance alcove. The walls,
floor, and ceiling of the room have been frozen
to make them difficult to select accidentally.

Tip: If the walls are hard to see, use Customize >
Customize User Interface > Colors to make the
viewport background a lighter gray.

If you were to render the scene now, you would
see a plain, bare room. This is the default
lighting from a single light source.

Room rendered with default lights

Add a light with a preset value to the entryway:

1. Choose Create > Lights > Photometric Lights
> Presets > 75W Bulb.

This creates a light object with a typical wattage.

2. In the Top viewport, move the cursor over the
alcove, and then click to position the light.

The light is now in the alcove.

Positioning the alcove light

If you look at the Left viewport, however, you
will see that the light is on the floor.

3dsmax.chm::/colors_panel.html
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By default, the alcove light is created at the level of the
floor.

3. Right-click the Left viewport to activate
it. Turn on Move, and then move the new light
up to the level of the ceiling.

Alcove light moved to ceiling level

If you were to render the scene now, it would
be very dim.

Adding a light turns off the default lighting.
Once you add a light, all the lighting for the
scene must come from light objects that you
place yourself. (The rendering also shows what
appears to be a bit of a light leak above the door
frame. Don’t worry about this: it won’t be
apparent once you add more lights.)

Add an overhead fixture:

For overhead lighting in the living room, you will
use a prepared light assembly from a separate
MAX file.

1. On the Create panel, turn
on Lights. Choose Photometric from the

drop-down list, turn on one of the light object
buttons, and then turn on the AutoGrid toggle.

It doesn’t matter which button you turn on.
You are not going to create a light from scratch.
However, AutoGrid should be on so the merged
light-fixture assembly will align with the ceiling.

2. Move or resize your 3ds Max window so you
can also see a Windows Explorer window.

3. Right-click a viewport and choose Unfreeze All
from the Display (upper-right) quadrant of the
quad menu.

AutoGrid doesn’t work well when the geometry
is frozen.

4. Drag the file ceiling.pendant.max from the
\tutorials\lights directory onto the Camera02
viewport in the 3ds Max window.

A pop-up menu appears, giving you the choice
of opening, merging, or cross-referencing the
scene with the ceiling pendant.

5. Choose Merge File.

The ceiling pendant geometry appears. It is
selected and because of AutoGrid, it is aligned
to faces in the scene.

6. Drag the light fixture until it is aligned with
the ceiling, and move it to a position near the
fireplace.

Top plan position of the ceiling pendant fixture



684 Chapter 6: Lighting and Rendering

Camera view of the pendant light

Now that you have a single light in the living
room, you can make instances of it to provide
the room with more light.

Freeze the room again:

1. Click to select the room object (Box01).

2. Right-click a viewport and choose Freeze
Selection from the Display (upper-right)
quadrant of the quad menu.

This keeps you from selecting and moving the
entire room, when you are trying to clone the
light fixture.

Make an array of light instances:

1. Activate the Top viewport and turn on
Move.

2. While holding down the Shift key, move
the light to the right along the X axis. (Watch
the Camera02 viewport so the light ends up
hanging from the ceiling, and not from the
skylight.)

Top plan position of the first cloned light

Camera view of the first cloned light

The Clone Options dialog appears.

3. In the Object group, choose Instance, and then
click OK.

4. Repeat steps 2 and 3 two more times, so you
have a row of four light fixtures.



Lighting an Interior Space 685

The first row of cloned lights

5. On the toolbar, make sure that the
Window/Crossing toggle is set to Window, then
drag in the Top viewport to select all four lights.

6. While holding down the Shift key, drag the
four lights up along the Y axis to add another
row, near the far wall.

The Clone Options dialog appears.

7. Make sure Instance is still chosen, and then
click OK.

Top plan view with two rows of ceiling lights

Render the scene:

• On the main toolbar, click Quick Render.

3ds Max renders the room.

Room lit by all lights (direct lighting only)

Now the living room is illuminated, and you
can see the colors on the walls. It still looks
rather shadowy, but this is only because the
rendering shows direct light only. In real life,
objects are illuminated by both direct light and
reflected (“bounced”) light. In 3ds Max, you
can add reflected light by calculating the scene’s
radiosity.

Room with radiosity calculated to provide bounced
(indirect) light as well as direct light

The radiosity solution shows that in fact,
you might want to turn down the level of
the living-room lights before making a final
rendering. The lesson Managing Multiple
Lights (page 691) shows some ways to manage
an array of instanced light objects such as those
you just created.
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Save your work:

• Save the file as room_with_lights.max.

Note: The scene interior_with_lights.max
contains the completed version, and the
scene interior_with_lights_and_radiosity.max
contains both the completed version and a
radiosity solution.

Summary

These are the main points of this lesson:

• If the model is to scale, use photometric lights.

• If you are lighting an indoor scene, position the
lights and fixture assemblies as you would in
the actual building, and use radiosity to model
bounced light.

Lighting a Close-Up of a Head

To light a subject, such as a talking head or a still
life, it helps to think in terms of how you would
light the same subject if you were working on a
stage set or in a photo studio. In other words, you
can place the lights wherever you want, adjust their
intensity, tint their color, and so on. There are
some widely used guidelines to lighting this way,
and this section introduces them briefly.

Note: As with architectural lighting, you can use
photometric lights, but they do the job only if
the scene has been modeled to a real-world scale.
In this exercise, you will use Standard lights to
simulate a 3-point lighting scenario like they do in
photo studios and television sets.

Set up the scene:

• In the \tutorials\lights directory, open the file
pito_head_shot.max.

The scene has a camera that is set up to render a
head shot of the 3D cartoon character named
Pito.

Look at the default lighting:

• On the main toolbar, click Quick Render.

3ds Max renders the camera view.
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Default lighting of Pito

This is not a bad rendering of Pito, but we can
do better.

Add a light:

1. On the Create panel, turn on
Lights, and then click Target Spot to turn it on.

2. In the Top viewport, drag from the bottom left
corner of the viewport to create a light that is
aimed at Pito’s head.

Aiming a target spot light at Pito

3ds Max creates the light. However, it is at
ground level.

Light is created initially at ground level.

3. In the Front viewport, use the Move tool
to move the spotlight so that it is slightly higher
than Pito’s head.

4. Select the spotlight target (small yellow square
and move it up to Pito’s eye level.



688 Chapter 6: Lighting and Rendering

5. Select the spotlight again (the yellow cone).

Go to the Modify panel, and on the
General Parameters rollout, turn on Shadows.
(The default method of Shadow Map will work
fine.)

6. In the Intensity/Color/Attenuation rollout, set
the Multiplier value to 1.5 to increase the light’s
intensity.

7. Right-click the Camera view to make it
current, and then click Quick Render.

We can see that Pito is illuminated on one side,
but the shadow areas are too dark. In general,
faces look better and more interesting if they
are lit at an angle, but one has to compensate
with a fill light to get rid of the dark areas. This
is why flash photos usually don’t look as good
as studio portraits.

Add a fill light:

1. On the Create panel, turn on
Lights, and then click Target Spot to turn it on.

In the Top viewport, click and drag to create a
target spot on the right side aiming at Pito. The
two lights can form about a 90-degree angle
with Pito’s face.
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2. In the Front view, move the fill light and its
target to about Pito’s eye level.

3. On the Modify panel, set the Fill light’s
multiplier value to about 0.6. A fill light is
usually less intense than a main light as its
purpose is to simulate global illumination
(bouncing light).

4. Activate the Camera viewport and then
click Quick Render.

Here is a good, balanced portrait of Pito.
Compared to the default light, it is brighter and
you can see more detail, but there are shadows
enough to make Pito look three dimensional.

Add a Back Light

A back light’s sole purpose is to separate the
character from the background. It is a light you
place behind the character to emphasize the
silhouette against the background. This can be
especially useful when shooting a dark-haired
character against a dark environment.

1. On the Create panel, click the
Lights button and then click Target Spot.

2. In the Left viewport, drag from above and to
the left of the character to create a light that is
aimed at Pito’s head.

3. With the backlight selected, go to the Modify
panel and notice that the backlight’s intensity
retained the Multiplier value of 0.6 used on the
previous light in the scene. Set the Multiplier
value to 0.4, as a backlight is typically the least
intense of all lights in a scene.

4. Activate the Camera viewport and then
click Quick Render.
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The brighter light, which you created first, is
known as the key light. The dimmer light,
which you added next, is known as the fill
light. For most subjects, you want to have a
single key light only, but you can add additional
fill lights to illuminate the background or
other hard-to-see places to simulate global
illumination. You can also vary the position of
the key light, to make the image clearer or more
dramatic. Finally, you added a backlight to
separate your character from the background.

Experiment:

The best way to understand how an individual
light is affecting your scene is to turn off all other
lights that are present. Try this:

1. Select the Main light (the first light you
created) and on the Modify panel, turn the
light off.

2. Also turn off the Fill light (the second light you
created).

3. With the Camera view current, click
Quick Render.

You can now see the individual effect on the
back light in the scene.

4. Experiment by turning the three lights you
created on and off, in different combinations.
When you are done, turn all three lights back
on before saving your file.

The effects of the individual lights on Pito: the Main light
(Left), Fill Light (Center) and Back light (Right).

Save your work:

• Save the scene as pito_lit.max.

Note: The three-point light version of the scene
is in pito_head_shot_final.max.

Summary

If you are lighting a single subject such as a head,
use a single key light and one or more fill lights.
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The key light is the brightest; the fill lights have a
lower intensity.

You can get different effects by changing the angle
of the light. Avoid lighting a subject directly from
the front.

Managing Multiple Lights

Interior architectural models typically have a large
number of light objects. This lesson demonstrates
some ways to manage lights, both when they are
instanced and when they aren’t.

Managing Instanced Light Objects

In architectural modeling, it’s common to use
instanced lights. Instancing allows you to control
the properties of all lights of a particular type
by editing the properties of just one of them.
However, you sometimes want to control lights
individually. This section shows you how.

Set up the scene:

• In the \tutorials\lights directory, open the file
instanced_light_array.max.

Note: All the files necessary to do the tutorials
can be found on the program disc. Before doing
the tutorials, copy the \tutorials directory from
the disc to your local program installation.

The scene shows a row of six light fixtures and
standard free spotlights, aimed at a wall. The
lights are instanced.

Render the scene:

• On the main toolbar, click Quick Render.

Wall illuminated by instanced light objects

Turn off one light:

1. Click to select the leftmost light
(Fspot01), and then go to the Modify panel.
On the General Parameters rollout, in the Light
Type group, click the On toggle to turn it off.

2. Click Quick Render.

Turning off an instance

Because the lights are instanced, turning off a
single light turns off all of them at once.

Hide some lights:

1. On the Modify panel, turn FSpot01 back on.

2. On the main toolbar, click
Window/Crossing to choose window
selection, and then in the Camera01 viewport,
drag a selection window to select the leftmost
three lights and their fixtures.

Tip: If the toggle is set to Crossing, then you
might select the box object as well. Avoid this.



692 Chapter 6: Lighting and Rendering

Lights and fixtures selected

3. Right-click, and choose Hide Selection from
the Display (upper-right) quadrant of the quad
menu.

The lights are now hidden.

4. Click Quick Render.

Rendering hidden lights

Although the lights are hidden, they still
illuminate the wall. Hiding a light has no effect
on its light-casting properties.

Turn off some lights by making them nonrenderable:

1. Right-click the Camera01 viewport, and choose
Unhide All from the Display quadrant.

2. Use click and Ctrl +click to select the leftmost
three lights, but not their fixtures.

Light objects selected, but not their fixtures

3. Right-click again, and choose Properties from
the Transform (lower-right) quadrant of the
quad menu.

The Object Properties dialog is displayed.

4. On the General panel, in the Rendering Control
group, turn off the Renderable toggle.

5. Click Quick Render.

Lights turned off using the Renderable property

Now you have the desired result. The
Renderable toggle can control whether an
instanced light casts light in the scene.

Save your work:

• Save the scene as render_toggle_light_
array.max.

Using the Light Lister

The Light Lister tool is a sort of master dialog
for lights in the scene. For individual lights, it
is a shortcut to controls on the Modify panel.
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(Its General settings also include settings on the
Environment panel.)

Set up the scene:

• In the \tutorials\lights directory, open the file
light_array.max.

The scene is the same as in the previous section,
but in this case, the lights are independent
objects, not instances.

Use the Light Lister to dim some lights:

1. Choose Tools > Light Lister.

The Light Lister dialog is displayed. There
is an entry for each unique light in the scene
(instances don’t appear on this dialog).

You might have to expand the dialog vertically
to see all the rows. As the dialog shows, the
scene contains six free spotlight objects, one
omni light, and one skylight.

Note: The Light Lister cannot control more than
150 unique light objects at a time. If there are
more than 150 unique lights in your scene,
the Lister displays controls for the first 150 it
finds, and a warning that you should select
fewer lights. Select fewer lights and then use the
Selected Lights configuration.

2. Change the Multiplier value to equal 0.3 for
all the free spotlights except the fifth one
(Fspot05). Leave the Multiplier for Fspot05 set
to 1.0.

Tip: You can use the standard Windows
Ctrl+C and Ctrl+V to copy and paste values

from one spinner field to another.

3. Click Quick Render.

Only the fifth light casts a full-strength beam.

Use the Light Lister to change light colors:

1. On the Light Lister, change the Multiplier value
for all the free spots back to 1.0.

2. Click the color swatch for the second light,
Fspot02.

The Color Selector is displayed.

3. Change the color of the second spotlight to a
light gold: R=255, G=191, B=52. Then click
OK.

4. On the Light Lister, drag the Fspot02 color
swatch to the Fspot04 color swatch.

A Copy Or Swap Colors dialog is displayed.

5. Click Copy.

6. Drag the Fspot04 color swatch to the Fspot06
color swatch. Once again, click Copy when
prompted to copy or swap colors.

7. Click Quick Render.



694 Chapter 6: Lighting and Rendering

Now alternating lights have alternating color.

Save your work:

• Save the scene as light_array_with_color.max.

Summary

• To control whether a light instance casts a
beam, you can use the light object’s Renderable
property, which is set from the Object
Properties dialog.

• The Light Lister is a convenient overall
“console” for adjusting lights in your scene.

Both photometric and standard lights use
shadow-mapped shadows by default. 3ds Max
offers some alternate ways to generate shadows, as
this lesson demonstrates.

Set up the scene:

• In the \tutorials\lights directory, open the file
shadows.max.

Note: All the files necessary to do the tutorials
can be found on the program disc. Before doing
the tutorials, copy the \tutorials directory from
the disc to your local program installation.

The scene is a classical sculpture against a
plain white background. It is lit by three
omni lights, but only one of them, Omni01, is
shadow-casting.

Render the scene:

• On the main toolbar, click Quick Render.

The statue’s shadow is shadow mapped. It has a
fairly sharp-edged outline.

Create a soft-edged shadow:

1. On the main toolbar, click Select
By Name. Use the Select Objects dialog to select
Omni01, and then go to the Modify panel.

2. Open the Shadow Map Parameters rollout.
Change the value of Sample Range to 10.0.

3. Click Quick Render.

The edge of the shadow is softer.
Shadow-mapped shadows can have soft
edges, but ray-traced shadows cannot.

3dsmax.chm::/object_properties.html
3dsmax.chm::/light_lister.html
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Use a ray-traced shadow:

1. On the General Parameters rollout, in the
Shadows group, choose Ray Traced Shadows
from the drop-down list.

2. Click Quick Render.

This time the shadows are very hard edged.

Note: 3ds Max offers two kinds of ray-traced
shadows: Advanced and “regular.” The
advanced option has more ways to adjust
shadow quality; otherwise, their behavior is
similar.

Make the shadow lighter:

1. On the Shadow Parameters rollout, in the
Shadow Parameters group, change the value of
Density to 0.4 (equivalent to 40 percent).

2. Click Quick Render.

The shadow is now lighter. Options on the
Shadow Parameters rollout are independent of
which kind of shadow you are generating.

Use an area shadow:

1. On the Shadow Parameters rollout, change the
value of Density back to 0.85.

2. On the General Parameters rollout, in the
Shadows group, change the shadow type from
Ray Traced Shadows to Area Shadows.

3. Open the Area Shadows rollout, which is now
displayed. In the Basic Options group, make
sure that Rectangle Light is chosen. In the Area
Light Dimensions group, change the Length
and Width to both equal 5.0.

4. Click Quick Render.

This time the results are even more diffuse than
a soft-edged shadow-mapped shadow. Area
shadows simulate shadows cast by an area of
light, such as a window or skylight, rather than
from a point source like a spotlight.

Tip: Photometric lights also provide true area
lights and linear lights.

Save your work:

• Save the scene as my_area_shadow.max.



696 Chapter 6: Lighting and Rendering

Summary

Photometric and standard lights both have
the same options for generating shadows. The
main choices are shadow-mapped (the default),
ray-traced, or area. Shadow-mapped shadows
can have a soft edge; ray-traced shadows are
always sharp edged; and area shadows are diffuse,
simulating shadows cast by a light-emitting area.

Each kind of shadow generator has its own
settings. The settings not demonstrated in this
lesson are mainly for adjusting shadow quality.
They are described in the User Reference.

Lighting a Scene with Standard
Lights

In general, photometric lights are preferred
over standard lights, because they are physically
accurate and behave more like real-world lights,
which makes them easy and straightforward to
set up. But you might encounter scenes that use
3ds Max standard lights. One situation in which
standard lights are the better option, is when the
scene geometry is not built to a real-world scale.
This lesson demonstrates the use of standard
lights.

Set up the scene:

• In the \tutorials\lights directory, open the file
memorial.max.

The scene shows a bust on a pedestal, in a
semicircular alcove.

Bust with default illumination

Add a photometric light:

1. On the Create panel, turn
on Lights. Choose Photometric from the
drop-down list, and then click Target Point to
turn it on.

2. In the Top viewport, drag to create the Target
Point light, pointing at the bust from an angle.

Photometric target point light aimed at the bust

3. On the main toolbar, click Quick Render.

What happened? The Camera01 viewport
shows a well-lit, even brightly lit bust, but the
rendered frame is nearly black.
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Diagnose the problem:

When you encounter a problem with photometric
lights, very often it has to do with the scale of the
scene. This is indeed the case in this scene.

• Go to the Utilities panel. Click Measure
to turn it on, then in a viewport, click the bust
model.

The measurements show that the bust is
about 340 units wide by 433 units tall. As one
“generic” 3ds Max unit corresponds to an inch,
this means in real-world terms, the bust is 28
feet wide and 36 feet tall! It was modeled before
3ds Max had photometric lights, when scale
was not an issue. But the default intensity of the
Target Point light is nowhere near great enought
to illuminate so monumental a sculpture.
Rather than increase the value to floodlight
intensity, it makes more sense to use standard
lights, which don’t depend on scale.

Add standard lights for key and fill:

1. Delete the Target Point light.

2. On the Create panel, use the
drop-down list to change the type of lights to
Standard. Then click Target Spot to turn on
this type of light.

3. In the Top viewport, drag to create two
spotlights at right angles to each other. Be sure
to turn on Shadows (on the General Parameters
rollout) for both lights. For the fill light on the
right, go to the Intensity/Color/Attenuation
rollout and reduce the Multiplier value to 0.4.

Two standard spotlights aimed at the bust: the key light
is on the left, and the fill light on the right.

4. Click Quick Render.

Bust rendered with standard spotlights and shadows

Now the rendering shows an illuminated bust.
However, the shadows are very harsh, and the
front of the supporting column is poorly lit.

Add additional fill lights:

In general, when you work with standard lights,
you need to provide more fill than when you use
photometric lights. (Standard lights aren’t really
suited for radiosity solutions.) In the case of this
model, a couple of Omni lights will help improve
the appearance of the rendering.



698 Chapter 6: Lighting and Rendering

1. On the Object Type rollout, click Omni to turn
it on, then in the Top viewport, click to place
a new omni light in front of the column, and
another just behind the bust, on the same side
as the fill spotlight.

These new lights default to a Multiplier value of
0.4, the last value you assigned.

Two omni lights added to provide additional fill and
make the shadows less harsh

2. Click Quick Render.

Additional fill lights make the shadows less harsh.

This is better, but the Omni light behind the
bust is a bit too bright.

3. Select the Omni light behind the bust,
and on the Modify panel, change its Multiplier
to 0.1.

4. Click Quick Render.

Reducing the level of the omni light behind the bust
makes the rendering easier to read.

This version of the rendering is a little clearer,
and looks more three-dimensional.

Save your work:

• Save your scene as memorial_with_standard_
lights.max.

The file memorial_finished.max has a
completed version of this scene.

Summary

These are the main points of this lesson:

• Use standard lights if the scene’s geometry is
not to scale.

• Base the lighting on a customary key and fill
light.

• Add Omni lights to provide additional fill and
simulate ambient, reflected light. Adjust their
Multiplier as necessary.

Tip: Avoid setting a standard light’s Multiplier
to a value greater than 1.0. This can result in
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washed-out areas of the rendering, especially if
you plan to transfer to video. Instead of using
greater-than-one Multipliers, add more light
objects.

Introduction to Rendering
To view the final results of your work in 3ds Max as
a two-dimensional image or movie, you render the
scene. By default, when you render, the software
produces a still image at a specific resolution using
the default scanline renderer, and displays it in a
separate window on the screen. But a wide variety
of rendering alternatives is available, and this
tutorial will introduce you to some of them.

Skill level: Basic

Time to complete: 2 hours.

Features Covered in This Tutorial

In this tutorial, you will learn how to:

• Render a still image to the screen and to a disk
file in different formats and resolutions

• Use different renderers and presets.

• Render a high-resolution image using multiple
computers.

• Render an animation and combine still images
into a movie file.

• Use a network farm to simultaneously render
different images from an animation.

• Use rendering to create textures for use in
games.

Tutorial Files

Note: All the files necessary to do the tutorials can
be found on the program disc. Before doing the
tutorials, copy the \tutorials directory from the
disc to your local program installation.

Rendering Still Images

In some ways, 3ds Max is like a photography studio.
You arrange and manipulate three-dimensional
objects, lights, and a camera, with the ultimate
goal of producing an image that illustrates your
message. The act of creating that image is called
rendering. In this lesson, you’ll learn some of the
different ways you can use 3ds Max to render.

Set up the lesson:

• On the File menu, choose Open and navigate
to the \tutorials\intro_to_rendering folder.
Highlight rendering_still_images_start.max
and click Open.

The scene contains a textured model of an
apple, plus a shadow-casting spotlight, a fill
light, and a ground plane.

Render the scene:

1. Make sure the Perspective (lower-right)
viewport is active; that is, it has a yellow
border. If not, right-click anywhere inside the
Perspective viewport.

2. Press Shift+Q or click the Quick
Render button on the main toolbar to render
the viewport.

In a few moments, a default rendering of the
apple scene appears on the screen.
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This rendering has several characteristics, all of
which you can change:

• It appears in the rendered frame window.
The text in this window’s title bar tells you
that you’re currently viewing frame 0 as
rendered from the Perspective viewport,
and the window is displaying the image at a
zoom ratio of 1:1, or normal magnification.

• Its resolution is 320 pixels in the horizontal
dimension and 240 pixels in the vertical
dimension, or 320 x 240 for short.

• It uses the default scanline renderer. This
is the renderer that most 3ds Max artists
employ, but others are available. One of
these is mental ray, a powerful renderer that
is included with the software. You’ll take a
quick look at mental ray shortly.

3. Close the rendered frame window by clicking
the X button in its upper-right corner.

The most efficient way to work with 3ds Max is
to use keyboard shortcuts whenever possible.
The default shortcut for the Quick Render
command is easy to remember.

4. On the keyboard, press Shift+Q .

The scene is rendered again, exactly the same
as before.

Use the rendered frame window tools:

The rendered frame window has a number of tools
you can use to work with the image and view it
in different ways. Most of these are available as
buttons in the toolbar, which is highlighted in the
illustration above. In this procedure, you’ll try out
a few of the other, mouse-related functions. You’ll
find detailed descriptions of all of the controls in
the Rendered Frame Window topic.

1. Click in the window to activate it, and then
rotate the mouse wheel forward and back.

If you’re not using a wheel mouse, you can
zoom the window by pressing and holding
the Ctrl key and then clicking the left mouse
button to zoom in, or the right mouse button
to zoom out.

The rendered frame window zoomed in

This zooms the image in and out about the
mouse cursor position. The current zoom
ratio appears at the right end of the text in the
window title bar. You can zoom between 1/8
and 64 times actual size.

You can change the window size using standard
Windows methods, such as by dragging the
lower-right corner.

2. When zoomed in, you can pan the image by
pressing and holding the middle mouse button

3dsmax.chm::/rendered_frame_window.html
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(or wheel button), and then dragging in the
window.

If you’re not using a three-button mouse,
pan the image by pressing and holding the
Shift key and the left mouse button, and then

dragging in the window.

3. Return to the 1:1 zoom ratio, and then, without
holding down any keys, right-click and hold in
the image portion of the window.

A temporary window appears, showing general
image data such as the resolution, as well as
specific information about the pixel currently
under the mouse cursor.

4. Still holding down the right mouse button, drag
the mouse so that the cursor is over a lighter
part of the image, such as the specular highlight
on the apple.

The color swatch at the right end of the toolbar
changes visibly to a light red color. This color
remains when you release the mouse button.

5. Close the rendered frame window.

Render with a different keyboard shortcut:

Did you notice that the apple is off-center? There
are different ways to fix this; you’ll do so by moving
the apple. You’ll also learn about using the Render
Last command.

1. On the toolbar, click the Select And
Move button, and then move the mouse cursor
into the Top viewport.

2. Position the mouse cursor over the apple (the
round, wireframe object), press and hold the
left mouse button, and then drag slowly to
the right. As you drag, watch the apple in the
Perspective viewport. When the apple is near
the center of the viewport, release the mouse
button.

Because you were working in the Top viewport,
it is now the active viewport.

3. Render the image by pressing Shift+Q .

The program renders the view from
the Top viewport. The Quick Render
command always renders the active viewport.
However, you probably wanted to see the
Perspective-viewport image. This is a common
error in 3ds Max. Fortunately, the program
offers a way around it, called Render Last.

4. Activate the Perspective viewport and render
again.

The new image replaces the previous one in the
rendered frame window.

5. Close the rendered frame window.
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6. Activate any other viewport, and then press
the F9 key.

This executes the Render Last command, which
renders the same viewport that you rendered
most recently in the current session, no matter
which viewport is active. It’s not available from
the toolbar, but if you remember the keyboard
shortcut, you can save time when working in
different viewports.

7. Press Ctrl+Z to undo the apple move. You
might need to press it more than once.

Explore rendering options and presets:

In this procedure, you’ll try a couple of options for
rendering objects that don’t normally appear. The
scene you loaded contains a hidden object and an
object that faces away from the camera. Neither
has shown up in the renderings so far.

1. Press F10 to open the Render Scene dialog.

The dialog opens to the Common panel.
Available here are controls for changing output
size, rendering to disk, and more. You’ll look
at some of these shortly. Right now, we’re
interested in the rendering options.

2. In the Options group, turn on Render Hidden
Geometry.

3. Render the Perspective viewport. If the
Perspective viewport is active, you can do this
by clicking the Render button at the bottom
of the dialog. If a different viewport is active,
first choose Perspective from the Viewport
drop-down list to the left of the Render button.

A second, green apple appears in the rendered
image. If your scene contains objects that you
want to appear in the rendered image but not
in the viewport, you can hide them, and then
use this option when rendering.

4. In the Options group, turn on Force 2-Sided.

5. Render the Perspective viewport again.
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The ground plane appears in the rendering,
with the apples casting shadows on it. This
object isn’t hidden, but because it’s facing away
from the “camera,” it doesn’t normally show
up when you render. This option is a handy
way to make sure all objects in the scene show
up in the rendered image, no matter which way
they’re facing.

A handy feature in 3ds Max lets you save a
custom rendering setup as a preset for use with
other scenes. You’ll try it now.

6. At the bottom of the Render Scene dialog, click
the Preset drop-down list, and then choose
Save Preset.

The Render Presets Save dialog appears.

7. Enter Hidden+2-Sided, and then click Save.

The Select Preset Categories dialog appears,
with a list of the different panels on the Render
Scene and Environment And Effects dialogs.
You can store any combination of panel settings
in a preset. By default, all are highlighted, but
for this exercise, you’re interested in saving only
the settings on the Common panel.

8. Click Common, the first item in the list, and
then click Save.

The preset is saved, and then appears in the
Preset list.

9. In the Options group, turn off both Render
Hidden Geometry and Force 2-Sided.

10.Click the Preset list, and then choose the
Hidden+2-Sided item.

The Select Preset Categories dialog appears,
showing only the Common item. If you save
a preset with multiple panels, you can choose
specific ones for selective loading.

11.Click the Load button.

The software loads the preset, and according
to its settings, turns on both Render Hidden
Geometry and Force 2-Sided again.

Change the output size:

Until now, you’ve been rendering to the screen at a
relatively small size: 320 x 240. 3ds Max lets you
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render at any size up to 32,768 x 32,768, however,
and in a number of different file formats.

1. Still on the Render Scene dialog, in the Output
Size group, click the 640x480 button.

The new output resolution appears in the
Width and Height fields.

2. Render the Perspective viewport.

The software renders the image at the new,
larger size. It takes a bit longer, but is much
easier to see.

The Image Aspect value, below the Width and
Height fields, is currently 1.333. This is the ratio
of width to height. You can alter it by changing
one of the dimensions.

3. Increase the Height value to 640.

The Image Aspect is now 1.0, which means that
the width and height are the same, resulting in
a square image.

4. Render the Perspective viewport.

The software divides the added height evenly
between the top and bottom of the image, so
there are now 80 additional pixels both above
and below the original image.

Tip: When rendering to nonstandard aspect
ratios, the Safe Frame option helps you preview
exactly how the final render will appear.
Right-click the viewport label (“Perspective”),
and then choose Show Safe Frame from the
menu. The outer frame shows you the area that
will render; the others are used when creating
video content.

You can also change the dimensions by
adjusting the Image Aspect value; this always
affects only the Height value. If you try it now,
be sure to set Image Aspect back to 1.0 when
you’re done.

You can lock the aspect ratio so that changing
one dimension automatically adjusts the other.

5. Click the lock button to the right of the Image
Aspect field.

Image Aspect becomes a read-only field.

6. Set the Height value to 480.

Both Height and Width change to 480.

7. Render the Perspective viewport.

The output image is still square, but smaller.

Change the output location:

Until now, you’ve been rendering only to the
screen. In this procedure, you’ll learn about
rendering to a disk file, and find out how to turn
off screen output.

1. In the Render Output group, near the bottom
of the Common Parameters rollout, click the
Files button.
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The Render Output File dialog appears.

2. If necessary, change the output location to
\3dsmax9\images\.

3. Click the drop-down-list next to Save As Type,
and choose BMP Image File (*.bmp).

This is the Windows Bitmap file format,
commonly used for image files in Windows.

4. Click in the File Name field, and type apples.
Press the Enter key.

5. The BMP Configuration dialog appears. Accept
the default choice, RGB 24 bit, by clicking OK.

The dialog closes. Nothing has rendered yet,
but in the Render Output group, Save File is
now available and enabled, and the read-only
below it shows the output path and file name.
These features become available only after you
specify file output properties with the Files
button.

6. Render the Perspective viewport using any of
the methods you’ve learned so far.

The software renders the image to both the
rendered frame window and the specified file.
You can see the latter with the View Image File
command.

7. From the File menu, choose View Image File.
Use the View File dialog to open the apples.bmp
file.

A new window opens showing the rendered
image. It’s exactly the same as the rendered
frame window, except that its title bar shows
the name of the file rather than the rendered
viewport.

8. Close both windows.

The software automatically appended the .bmp
filename extension when you specified the file
type. You can also specify the file type explicitly
by including the extension in the file name.

9. Click the Files button again, and change Save
As Type back to All Formats (at the top of the
list). Then change the file name to apples.tga.
Press Enter .

10.The software recognizes that you want to render
the image in Targa format, and displays the
Targa Image Control dialog. The Targa image
format supports the alpha channel, which
allows transparency effects when compositing
the rendered image.

11.Click the OK button to accept the Targa image
defaults.

12.Near the bottom of the Render Output group,
turn off Rendered Frame Window.

13.Render the Perspective viewport.

The software renders the image to the specified
file, but not the rendered frame window. You
can see the Targa image file with the View
Image File command.

If you click the Display Alpha Channel
button on the window toolbar, you can see
a tiny bit of transparency (black) in the
upper-right corner. This is where the ground
plane ends, showing the background, which is
usually transparent.

14.Close the image window.
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Use a different renderer:

Included with 3ds Max is a powerful, sophisticated
renderer called mental ray. Full exploitation of its
capabilities is beyond the scope of this tutorial, but
basic usage is straightforward.

1. In the Render Output group, turn off Save File
and turn on Rendered Frame Window.

2. Scroll down to the Assign Renderer rollout and
click the rollout title bar to expand it.

3. Click the top Choose Renderer button, to the
right of Production.

The Choose Renderer dialog appears.

4. In the list, click the mental ray Renderer entry
to highlight it, and then click OK.

”mental ray” appears as the production
renderer.

5. Render the Perspective viewport.

The software renders the image to the rendered
frame window. During the rendering process,
you can see the small rectangles, or “buckets,”
into which mental ray subdivides the image,
appear one by one.

In the final image, the red and green apples and
the ground plane all appear, because mental

ray supports the same options as the default
scanline renderer.

Other renderers are available as plug-ins;
after installation, they appear on the Choose
Renderer dialog.

6. Restore Default Scanline Renderer as the
production renderer.

Rendering an Animation

There are some specific techniques to learn for
rendering your animation into a movie file. You
can render directly to a movie format such as
AVI, or you can render a sequence of still image
files to file formats such as TGA and then use the
RAM Player to save them into a movie. The latter
method is the recommended choice. It’s a few steps
more than rendering directly into a movie, but it
gives you more control over file size and quality of
output, plus if you have frames with artifacts or
other errors, you can repair or remove them.

Warning: The next lesson will take a long time to render.

Depending on the speed of your PC, it can take several

hours or more to render the individual frames.

Set up the scene:

• From the \tutorials\full_house directory, open
full_house_walkin_start_render.max.

If you get a Units Mismatch dialog, choose
Adopt The File’s Unit Scale and click OK. In
general, when encountering this dialog, choose
Adopt Unit Scale.

This is a large file, so it will take a while to load.
This file has stored all the radiosity rendering
information, so the render times will be quicker.
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This file is similar to the one created in the
earlier walkthrough lesson. It has been reduced
from 730 frames to 257 frames to shorten the
total rendering time.

Render to an image sequence:

1. If the Camera viewport isn’t active, right-click
in it to activate it.

2. From the Rendering menu, choose Render.

Next, you’ll define the animation range.

3. On the Common tab of the Render Scene
dialog, in the Time Output group, choose
Active Time Segment.

This option automatically renders all currently
playable frames. Alternatively, you could
choose Range or Frames and set the frame
range to render.

4. In the Render Output group, click the Files
button.

The Render Output File dialog opens.

5. Navigate to a directory where you want to save
your work. You can use the Create New Folder
button to establish a new location, if necessary.

Warning: Make sure you don’t choose a directory on

a DVD drive or some other write-protected location.

Also make sure you choose a location with plenty of

free space.

Next you’ll define the type of still image file to
render.

6. In the Save As Type field, click the drop-down
arrow and choose Targa Image File, (*.tga ...).

This is a high-quality file type, good for this
kind of rendering.

7. In the File name field, type my_walkin.tga,
then click Save.

After you click Save, you see a format-specific
dialog that asks you to specify attribute and
information settings. You can accept the default
values, and then click OK.

When you render an still-image sequence,
as in this case, the software automatically
appends the first part of the file name with a
four-digit frame number. So the first frame
will be my_walkin0000.tga, the second will be
my_walkin0001.tga, and so on.

8. Make sure Save File is turned on in the Render
Output rollout, and that the Viewport field at
the bottom of the Render Scene dialog reads
Camera03 (not Top, Front, or Left), then click
Render.

The Rendering dialog appears, or you may first
see a Raytrace Messages dialog. Wait for a short
while as the first frame is rendered. You will see
the Last Frame Time, Elapsed Time, and Time
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Remaining values change after the first frame
finishes.

If you did see the Raytrace Messages dialog,
click the Raytracer tab of the Render Scene
dialog, and then turn off Show Messages.

9. Allow at least four frames to render.

10.At this point, you can go away and return once
your rendering is complete.

Tip: You could also sit and watch the rendering
for errors or improvements. In the real world,
this can be a good idea; to study what you are
creating.

When the rendering is finished, the target
directory contains the 258 output files.

Convert an image sequence into a movie:

1. From the Rendering menu, choose RAM Player.

The RAM Player loads still image sequences
into memory and plays them so you can watch
them as a movie. It actually lets you load two
different sequences and then compare them
visually, but you won’t use that functionality
here. You’ll simply use the RAM Player to save
the files into an AVI file.

2. On the RAM Player toolbar, click Open
Channel A.

3. In the Open File Channel A dialog, navigate to
the sequence of TGA image files. Highlight the

name of the first file in the sequence, then turn
on Sequence, and click Open.

Now the RAM Player will load the sequential
image files, rather than just the first one.

The Image File List dialog appears. Here you
can use the Every Nth and Multiplier fields
if you need to speed up or slow down your
animation. If your animation is too slow,
change Every Nth to 2 or 3. If your animation is
too fast, increase the Multiplier.

4. Click OK.

The RAM Player Configuration dialog appears.
Here you can observe and adjust your memory
usage. Loading this sequence takes about 57
MB. There are also tools here to resize your
animation, specify a range of frames to use, and
split the alpha (transparency) information into
a separate file.

5. Increase the Memory Usage to its maximum for
your system, then click OK.

The RAM Player loads the file into memory.
In the Loading dialog, observe how much
memory is being used and remains available.

If it looks like you are about to run out memory,
click Stop Loading. If you have a low-memory
system, reduce the number of frames to load
and try again.

6. On the RAM Player toolbar, click the Play
button and watch the movie play.



Creating an Animated Shadow Study 709

7. On the RAM Player toolbar, click the Save
Channel A button.

The Save File dialog appears.

8. Choose AVI as the file type, and give the
animation the name my_walkin.avi. Click
Save.

The Video Compression dialog
appears. Here, you can choose a codec
(compression/decompression type) and adjust
the quality of the file. To reduce file size, lower
the quality.

9. Click OK to continue.

10.When the file conversion is finished, close the
RAM Player, and then from the File menu,
choose View Image File. Play your finished AVI
file and observe the results.

Summary

You have learned how to render your animation
to a sequence of still image files. This allows
you better control for later correction of your
animation. You also learned how to assemble the
still image sequence into a movie file, such as AVI
or QuickTime, using the RAM Player.

Creating an Animated Shadow
Study

In addition to animating a camera, you can
animate the Daylight system’s time of day. This is a
good way to create a shadow study.

Set up the scene:

• From the \tutorials\high_rise\ folder, open
cityscape.max. If you encounter a File Unit
Mismatch message, choose Adopt Unit Scale,
the second choice.

This is a scene of nine city blocks, with a
skyscraper at the center. The scene contains a

Daylight system. The Daylight system is set
to position the scene at the latitude of San
Francisco, California, and the sun is set at 0700
hours, about the time of dawn on a winter day.

Animate the daylight:

1. Make sure Select Object is active on the
toolbar.

2. In the Left viewport, click the sun object in the
viewport to select it.

Daylight01 appears in the name field on the
command panel.

3. Open the Motion panel.

4. On the Motion panel, scroll if necessary to the
Control Parameters rollout.

5. Turn on the Auto Key button.

The button, the track bar, and the
border of the active viewport all turn red.

6. Drag the time slider to frame 5, and then on the
Control Parameters rollout, change the Hours
value to 8.

The spinner arrows of the Hours, Minutes,
and Seconds fields are now bracketed in red,
indicating that you have set a key to animate
the time of day.
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7. Drag the time slider to frame 10, and then
change Hours to 9.

8. Continue dragging the time slider in five-frame
increments, then increasing the time of day by
one hour at each increment. Stop when the time
is 17 hours (5 P.M.). This should be at frame 50.

You have set 10 keyframes (and 3ds Max has
automatically set one at frame 0, as well) to
track the course of the sun through a day. Drag
the time slider and watch the Left viewport.
The sun moves smoothly: 3ds Max interpolates
from one keyframe to the next so each frame is
different, even if it doesn’t have a key on it.

Set the animation range:

As the animation only lasts 51 frames (0 to 50),
you don’t need the full default range of 101 frames.

1. Click Time Configuration.

The Time Configuration dialog is displayed.

(This button is at the extreme lower right of the
3ds Max window.)

2. In the Animation group, change the value of
End Time to 50, and then click OK.

Now the range of frames is no greater than the
length of the animation.

Save your work:

• Choose File > Save Copy As. In the file dialog,
name the file my_shadows.max, and then click
Save.

Important: Save Copy As does not open the copy.

The active file is still cityscape.max.

Tip: Always save your scene file before you
render.

Render the animation:

Rendering the animation takes about half an hour
on a high-speed system. If you want, you can skip
these steps and just view the file shadow_study.avi,

provided with the other tutorial files. See “View
the animation,” below.

1. Choose Rendering > Render.

The Render Scene dialog is displayed, with the
Render panel active.

2. On the Common Parameters rollout, in the
Time Output group, choose Active Time
Segment: 0 To 50.

In the Output Size group, make sure that the
resolution is 640x480.

A smaller size would render more quickly, but
the shadows don’t show up as well.

3. On the Render Output rollout, click the Files
button.

A Render Output File dialog is displayed.

4. Enter a name for the animation, and choose
one of the animation formats from the Save As
Type drop-down list, and then click Save.

You can render an animation to either the AVI
or MOV (QuickTime®) formats. After you click
Save, you see a format-specific dialog that asks
you to specify the animation’s compression.
You can accept the default values, and then
click OK.

Note: In practice, it’s a good idea to avoid
rendering directly to movie formats such as
AVI or MOV. Instead render to sequentially
numbered still image frames, and then convert
them to a movie format as a second step.
This has practical value if you need to correct
mistakes in individual frames, without having
to re-render the entire animation.

5. Open the Assign Renderer rollout and confirm
that the Default Scanline Renderer is the
production renderer. If you see mental ray
renderer click Choose Renderer and change the
renderer back to the Default Scanline Renderer.

Note: The mental ray renderer does not support
the IES Sun lighting.
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6. Leave the other Render Scene settings as they
are, make sure Camera02 is the active viewport,
and then click Render.

3ds Max renders the animation. This takes a
while (about a half hour on the high-speed
system), so this is a good point to take a break.

View the animation:

1. When rendering is done, choose File > View
Image File.

A View File dialog appears.

2. Choose the file you just rendered, and then
click Open.

Tip: You can also choose shadow_study.avi,
which is provided with the other tutorial files.

Depending on the movie type, a Media Player
or a QuickTime viewer is displayed, which lets
you play the animation.

Summary

You can create a shadow study by animating the
time of day of a Daylight system. To do so, use the
Auto Key button, and change the hour at regular
intervals of frames. (The longer the interval, the
slower the animation will play.)
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Rendering with mental ray:
Final Gather and Global
Illumination

Interior Architecture Rendering
Tutorial

The following tutorial allows you to become a
mental ray wizard for interior archit
two-hour sessions. Enjoy the trip.

The scene used for the tutorial, sho
below, incorporates an interior room
daylight/sunlight. All materials use t
ray Arch & Design material that’s pa
ray 3.5 and is included in 3ds Max.
ecture in two

wn
with

he new mental
rt of mental

Next we show the scene rendered, without any
global illumination. It is quite dark, as sun hits
only a part of the scene. This is ideal for testing
global illumination algorithms, as the dark parts
will get all their light indirectly.
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Scene rendered

Tip: To achieve optimal performance, we
recommend that you use the mental ray Arch
& Design material wherever possible. This
material uses sophisticated importance-sampling
techniques that can produce substantial overall
speedup. A performance factor of up to 10 times
is possible for final gather, especially glossy
floors as well as materials with weak reflections.
Improvement can be even greater with more
bounces.

Skill Level: Intermediate to Advanced

Time to complete: Three to four hours.

Features Covered in this Tutorial

The tutorial consists of four sections:

• The first section describes final gather (often
shortened as FG), including multibounce.

• The second section describes photons. Due to
being the first global-illumination technique
implemented in mental ray, the mental ray
interface groups photon techniques under the
GI heading.

• The third section shows how to combine final
gather and photons to get better performance.

• The last section briefly shows how to combine
final gather and ambient occlusion.

Tutorial Files

All the files necessary to do this tutorial can be
found on the program disc. Before doing the
tutorials, copy the \tutorials directory from the
disc to your local program installation.

In This Tutorial

Final Gather (page 713)

Final Gather and Ambient Occlusion (page 721)

Photons (page 723)

Photons and Final Gather (page 730)

Final Gather

Final gather shoots rays into the scene. For each
pixel (surface point on the geometry like walls) it
shoots many rays into the scene. It measures the
brightness of the rays to compute how much light
gets to a given surface point.

Set up Final Gather:

1. From the \tutorials\mental_ray\ folder, open
the scene file fg+gi_start.max.

The scene is set to render with mental ray.

2. Press F9 to render the scene.

As shown in the previous section, the interior
is very dark, with daylight coming in from the
window.

3dsmax.chm::/arch_design_material_mental_ray.html
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Scene rendered

3. Press F10 to open the Render Scene dialog.
On the Indirect Illumination panel > Final
Gather rollout, turn on Enable Final Gather and
then choose the Draft preset.

Activate FG

4. Click the Render button to compute an image.

Final gather provides more realistic lighting,
allowing the daylight to illuminate the darker
portions of the scene.

Visualize Final Gather points:

To best understand and use final gather, it helps to
have a notion of the underlying concepts. You’ll
start with final gather points.

1. On the Processing panel > Diagnostics rollout,
turn on Visual > Enable and then choose Final
Gather.
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FG diagnostic enabled

2. Render the scene again.

Each final gather point is displayed as a green
dot.

At each final gather point mental ray shoots
a bundle of rays into the scene to check how
much light is hitting the point. You control
the number of rays with the Rays Per FG Point
setting.

Interpolate FG Points:

One of easiest-to-understand parameters is
Interpolate Over Num FG Points. This determines
how many FG points are used to compute the final
result. By default the parameter value is 30, which
causes 29 neighbors to be combined with each FG
point.

The following illustration shows a zoomed area
of the image. One pixel is marked with a red
cross. The eight closest FG points are inside a red
outline. If Interpolate Over Num FG Points is set
to 8, mental ray would take these eight points to
interpolate.

Eight points (green) interpolated to get color at red cross

The following images show the results of setting
Interpolate Over Num FG Points to values between
1 and 200.
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Interpolate Over Num
FG Points=1

Interpolate Over Num
FG Points=5

Interpolate Over Num
FG Points=30

Interpolate Over Num
FG Points=200

Feel free to try each of these to see the results on
your screen.

At 1 the image is very noisy; at 5 it’s a bit smoother
but still noisy. At 30, the rendered image looks
quite realistic, and at 200 the result is absolutely
smooth. The great news is that increasing
Interpolate Over Num FG Points costs very little

performance: Setting it to 200 takes, at most, only
a few minutes longer to render than at 1, even
with large, complex scenes that take a long time
to render.

So why not always use 200? Because interpolation
removes local details. For example, the ceiling
near the window looks very flat in the 200 image.

Interpolation is the best choice when you need a
noiseless image but long rendering times aren’t
practical.

Density

The next parameter we discuss is Initial FG Point
Density. This is the density of the final gather
points grid, which covers the entire image. Density
species the grid spacing. The following images
start with the Draft preset and vary only the
density. Note that Noise Filtering is off (None).

Density varies from 0.01 at the top to 4.0 at
the bottom. As the value increases, so does the
number of green dots (final gather points) in the
diagnostic images.
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Initial FG Point 
Density=1.0

Initial FG Point 
Density=1.0
(Diagnostic)

Initial FG Point 
Density=0.1
(Diagnostic)

Initial FG Point 
Density=0.1

Initial FG Point 
Density=0.1

Initial FG Point 
Density=0.1
(Diagnostic)

Initial FG Point 
Density=4.0
(Diagnostic)

Initial FG Point 
Density=4.0

Initial FG Point
Density=0.01

Initial FG Point
Density=0.01 

 
 

This image shows perfect details already, but
it also introduces some noise. Increasing the
interpolation is one way to resolve the noise. An
alternative way is shown below.

Higher density shows more detail. Whenever you
need more detail in a scene, increase the density.
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Rays Per Point

Each FG point shoots a bundle of rays into the
scene. You can specify the number of rays with
the Rays Per FG Point parameter. Using a low
value is faster but can generate noise. A high
value can reduce or eliminate noise, but takes
longer to compute. To show how this influences
rendering, start with the Low preset and then turn
off interpolation by setting Interpolate Over Num.
FG Points to 1.

Set Rays Per FG Point to 1 and then render.

Here you see individual FG points, with each FG
point shooting exactly one ray.

One ray per FG Point

Rays Per FG Point=4 Rays Per FG Point=50

Rays Per FG Point=500 Rays Per FG Point=10000

The image with 10,000 rays can take some time
to render. The image is quite good without any
interpolation. Adding a bit of interpolation can
resolve any remaining noise.

Density versus Rays

When should you increase grid density, and when
should you increase the number of rays per FG
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point? Why not have a single control? And when
should you modify the number of rays per FG
point?

More rays are required for scenes with a small
bright window (high contrast inside the scene).

Fewer rays are required for a scene with even
illumination, like a white office room with many
light sources at night (no daylight).

Typical values are:

• fewer than 50 rays for even illumination (low
contrast)

• 100-500 for average scenes

• 1,000-10,000 for high-contrast scenes

The scene for this tutorial has very high contrast,
with close to 100,000 lux in the sun near the
window. The rest of the scene receives no direct
illumination, because there are no light sources
inside the room.

Multibounce

The image still has dark corners. This is because
we’ve been using final gather with no bouncing
of light from one object to another. For example,
illumination of a windowless hallway comes only
from light bouncing several times: from window
to wall to wall to hallway. In our scene, the area
behind the sofa needs several bounces to “see" the
sun.

To solve this we increase the Diffuse Bounces value
to 5:

More bounces will distribute light correctly in
the scene. For average scenes, five bounces are
sufficient. Extremely white scenes could require
up to 10 bounces, while dark-textured interiors
might not need more than three.

Increasing the number of bounces increases
rendering time. Using five bounces needs roughly
five times as long to render.

1. Try a test rendering with the Draft preset and
Diffuse Bounces set to 5.

This produces a fairly bright image.



720 Chapter 6: Lighting and Rendering

If that’s too bright, adjust the Logarithmic
Exposure Control > Brightness setting. The
default value is 65.5, but in this scene it’s set to
28.8.

It’s generally good practice to test total
brightness with a draft rendering. Adjusting
the exposure control is then easy.

Later you can add detail (density) and reduce
noise by adjusting interpolation and increasing
the number of rays per FG point.

2. The Medium preset can help reduce noise
and artifacts. Choose the Medium preset, set
Diffuse Bounces to 5, and then render.

The image looks quite good, but to improve
quality further you can:

• increase density to see more details, such as
contact shadows.

• increase interpolation to get a smoother
image.

• increase the number of rays.

3. The Medium preset didn’t show significant
noise, so increase Initial FG Point Density (this
controls lighting detail) to 2.0, and Interpolate
Over Num. FG Points to 50. Also, turn on
Final Gather Map > Read/Write File, click the
ellipsis [...] button, and enter the file name
tut_mediumPlus.fgm. This saves the final
gather information to disk, so you can then
quickly try different values for interpolation.
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4. To further improve the image, reduce the
aliasing around the window by increasing
oversampling (Samples per Pixel) to 4-16. This
works independent of final gathering, for any
rendering.

Initial FG Point Density=2.0; Rays per FG Point=250

5. Re-rendering with Interpolate Over Num.
FG Points set to 100 gives a perfectly smooth
image. An even better image can be achieved
by increasing Rays Per FG Point.

Next

Final Gather and Ambient Occlusion (page 721)

Final Gather and Ambient
Occlusion

In architectural rendering, one often needs to
present a new image to a customer in a very short
time. To get this done in a few minutes instead of
hours, you can combine final gather with ambient
occlusion (AO).

What is ambient occlusion? Briefly, it darkens
occluded areas. For example, at the intersection of
a wall and a floor, occlusion is higher than in the
middle of the floor. Ambient occlusion does not
transfer colors between surfaces; it simply darkens
them.

To get a quite good image in minutes instead of
hours, use final gather with a low density, such as
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0.1. This is very fast and distributes light, including
colors, in the scene. To get contact shadows and
local details, add ambient occlusion. mental ray
has special support for ambient occlusion that
makes this fast.

The new mental ray Arch & Design material can
do AO directly, in a single pass.

Use material-based Ambient Occlusion:

1. If not continuing from the previous lesson,
from the \tutorials\mental_ray\ folder, open the
scene file fg+gi_start.max. Open the Render
Scene dialog, and on the Indirect Illumination
panel > Final Gather rollout, turn on Enable
Final Gather.

2. On the Indirect Illumination panel > Final
Gather rollout, choose the Draft preset and set
Diffuse Bounces to 5, if necessary.

3. Open the Material Editor and modify the floor
material: On the Special Effects rollout, turn on
Ambient Occlusion. Do the same for the wall
material.

4. Render the scene.

Final Gather only Final Gather combined
with ambient occlusion

The image with AO has good contact shadows
and edges.

5. A final touch is to reduce the noise on the back
side of the sofa. Increase the Interpolate Over
Num. FG Points value to 100.

FG and AO with more interpolation

This is the combination of the Draft FG preset
with AO. You can also use the Medium preset to
improve quality at the cost of rendering time.

General notes on AO

Make sure AO is applied only locally within a small
radius, just to bring out the small details, and let
FG handle the coarser transport of light. A good
rule of thumb is to set the AO radius to about 4
inches (100mm); this is the default setting.

If you think the “darkening” effect of AO is too
strong, you can modify the Shadow Color value in
the Ambient Occlusion group to a lighter color,
such as 50 percent gray (set Value to 0.5).

Next

Photons (page 723)
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Photons

Using photons requires a certain degree of
expertise, which you’ll gain in this lesson. In many
cases, final gather and final gather multibounce
will suffice and be easier to control, with good
performance.

Using photons without final gather rarely gives
better results or performance. Combining final
gather with photons can give a speedup of up to
five times (see below).

When to use photons

Use photons to distribute energy rapidly in a
scene. Photons can easily perform many bounces.

When shouldn’t you use photons? Photons don’t
like to jump through a keyholes. Imagine a dark
room that is lit only through a keyhole.

Use photons when a room is rather evenly
lit, in which case the photons can replace FG
multibounces. Set Diffuse Bounces to 1, and
combine it with photons.

Preconditions for using photons

It is very important to use "physically correct"
lights with photons. If the photons shot by the
lights do not match the "direct light" shot by the
lights, images will not look good.

In 3ds Max, all lights in the Photometric category
do this automatically, whereas the standard
lights are not guaranteed to perform in the same
way, automatically. This is another reason for
recommending that you mostly use FG. It works
with any light, no matter how "unphysical,” since it
is concerned only with the transport of light from
surface to surface, not the transport of light from
the light to the surface.

Also note that the mental ray Sky light does not
shoot photons, which explains why the following

renderings will be darker compared with FG. Until
it does, you can use blue tinted photometric area
lights in windows as a substitute, although we will
not do that here. Also, the color tint is different, as
blue light from the sky is missing, and most light
(photons) from the sun hit the wooden floor first,
which adds a tint.

Regarding interior renderings with lights other
than sun/sky: If you plan to use photons, stick to
the photometric lights. If you plan to use only FG
multibounce, any light will work.

What are photons?

Photons in mental ray simulate real-world
photons. They’re reflected by mirrors, refracted
through glass, and scattered on diffuse and glossy
surfaces. The tutorial scene uses mostly diffuse
surfaces; the walls in the scene have a heavily
diffuse material. The sunlight that directly hits the
wooden floor scatters into the room, and photons
continue to bounce from wall to wall, due to the
bright materials.

Note: For most scenes, using only photons is not
the best choice. For best results, combine photons
and FG. The goal of this section is to provide
information required to understand photons
in depth. This serves as a good basis for later
combining photons with FG.

The following steps explain the usage of photons
in mental ray. First we show that we indeed have
individual photons, and then later we show how
to get a smooth image.

1. If not continuing from the previous lesson,
from the \tutorials\mental_ray\ folder, open the
scene file fg+gi_start.max. Open the Render
Scene dialog, and on the Render Scene dialog
> Indirect Illumination panel, turn on Global
Illumination (photons).

2. If you’re continuing from the previous
lesson, on the Render Scene dialog > Indirect

3dsmax.chm::/mr_sky.html
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Illumination panel, turn off Enable Final Gather
and turn on Global Illumination (photons).

Enable Final Gather is off.

Global Illumination (photons) is on.

3. Set Maximum Num. Photons Per Sample to 2,
set Maximum Sampling Radius to 10.0mm,
and make sure Light Properties > Average GI
Photons Per Light is set to 10000.
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This image shows the photons. In nature,
areas that have a higher density of photons are
brighter. The major advantage of photons in
mental ray is that they simulate this natural
phenomenon, including reflections from metal
and refraction through glass.

To get from individual photons to a smooth
image, increase the radius and the number of
photons looked up.

4. Set Maximum Sampling Radius to 100mm (0.1
meter).

The image isn’t smooth yet, but we have
brightness nearly everywhere.

5. Increase the radius even further:

Maximum
Sampling 

Radius=
200.0mm (0.2m)

Maximum Sampling
Radius=500.0mm (0.5m)

Even with larger Radius settings (see preceding
illustrations), the image is nearly identical.
Why? Because we need more photons in
the lookup. So far we’ve looked for only
two photons, but a medium-quality image
needs around 100 photons in the lookup. A
high-quality image starts at 1,000 photons in
the lookup. The following renderings increase
the number of photons looked up, keeping the
radius at 0.5 meter.

6. Set Maximum Num. Photons Per Sample to
100 and render.
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100 (max.) photons per sample

This image shows something to watch out for
with photons: a light leak. Because mental ray
is looking up photons in a large radius (0.5
meters), it might actually pick up some photons
that have struck an object on the other side of
the wall! This is what causes the bright streak
in the far corner.

Otherwise, this image is already quite good,
and rendering time is fast. The next step is to
further increase the number of photons.

7. Set Maximum Num. Photons Per Sample to
1000 and render.

1,000 (max.) photons per sample

The image is now smooth, but looks washed
out.

Further increasing the number of photons to be
looked up will not increase image quality. We
have a total of only 10,000 photons in the whole
scene. We simply do not find more than 1,000
photons inside a radius of 0.5m. We could ask
for a million, but we will not find more. To find
more one could increase the radius, to catch
more photons..

The image with a radius of 0.5m and 1,000
photons to be looked up is smooth, but lacks
detail. How to add it?

We can suggest 2 1/2 strategies: The first is
to shoot more photons into the scene. This
lets you reduce the radius again, resulting in
increasingly greater detail. We will describe
this shortly with regard to the following
three images, with the intent to increase your
understanding of photon density versus image
quality. The second strategy is to add final
gather, which is often the best solution. The
additional “1/2” strategy is to use photons
for the overall light distribution, and ambient
occlusion for the detail.
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The silver rule for photons is: Shoot four
times more photons from the light to decrease
the radius by 2. This keeps roughly the same
number of photons inside the area covered by
the radius.

8. Render three images:

• one with Light Properties > Average GI
Photons per Light=40000 at radius 250mm
(0.25m)

• one with 160000 photons at radius 125mm
(0.125m)

• one with 640000 photons at radius 70mm
(0.07m)

radius 0.25m,
40k photons

radius 0.125m, 160k
photons

radius 0.07m, 640k photons

As the radius gets smaller, the light leak in
the rear corner on the right wall shrinks, and,
in general, detail returns. However, some
low-frequency noise is visible.

This happens primarily because when the
radius is smaller we see more detail, including
more noise. This leads us to the golden rule for
photons: To reduce the radius by 2, shoot 4 x
1.4 times the number of photons, and increase
the number in the lookup by 1.4.

You can save and reuse the photon map
independent of geometry and image size;
doing so can dramatically speed up rendering
for a camera walkthrough. Here we save it
to try different lookup options to resolve the
low-frequency noise. We run once with 2.5
million photons shot from the light source and
store it in the photon map file.

9. On the Caustics And Global Illumination (GI)
rollout, set Light Properties > Average GI
Photons Per Light to 2500000.
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10.On the Caustics And Global Illumination (GI)
rollout, in the Photon Map group, turn on
Read/Write File and then click the ellipsis [...]
button. Specify a path and filename, and then
render the scene. The render should take a few
minutes.

You can use a saved photon map arbitrarily,
even with a completely different scene for
artistic purposes. The photon-emission phase
takes place instantaneously with a saved photon
map. When tuning lookup with a large number
of photons, using a photon map can save a great
deal of time.

To remove the low-frequency noise you can
increase the number of photons in the lookup;
for example, to 10000. If the rendering time
doesn’t go up, it means that there are not more
photons inside a 125mm radius. You then need
to increase the radius a bit, to get to a point
where mental ray finds more photons again.

In this image the low-frequency noise is gone,
but the light leak remains.

Maximum Sampling Radius=70.0mm

Here the light leak is gone, but noise is visible.

Maximum Sampling Radius=30.0mm

How to resolve this? To remove the noise you
could increase the radius, but this also causes
the light leak. An easy fix would be to place
a black object on the outside of the building
so photons don’t get stored there. If this isn’t
suitable, you need more photons in the lookup.
A frequent misunderstanding is simply to
increase the lookup, for example to 20,000
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instead of 10,000. This helps only if mental ray
indeed finds enough photons inside the radius.
If not, you need to shoot more from the light
source.

The limit to quality with photon maps is
memory. For small radii, mental ray needs
many photons. Most 32-bit versions of
Windows can access up to two gigabytes of
memory, while the extended version allows up
to three gigabytes. If you export an MI file to
the standalone version of mental ray, you can
eliminate the application’s (3ds Max) memory
footprint, thus making additional memory
available to the renderer.

Photon merging

Photon merging is a new feature in mental ray
3.5 that lets you create an optimized photon map,
which enables bringing more photons to dark
areas of a scene. Photons inside a given radius
are merged, and thus consume less memory.
Especially bright areas have many photons close
to each other, consuming a lot of memory.
Using merging in bright areas reduces memory
requirements. You can shoot many more photons
before hitting memory limits. Typical values can
be 10 million to 50 million photons.

Use photon merging only when a larger number
of photons is required. This feature is intended
primarily for advanced users. The procedure is:

1. Set the merge radius to 3-5 percent of the
regular lookup radius.

2. Massively increase the number of photons shot
from light sources.

Using a merge radius larger than 5 percent typically
does not help. Shooting more photons from light
sources is a must. Merging alone solves memory.
Shooting more photons improves quality.

• As an example of photon merging, we can
use the current scene, which has 2.5 million

photons. Now try shooting 10 million. Turn on
Merge Nearby Photons and set the merge radius
to 1.0mm. The lookup (Maximum Sampling)
radius is 30.0mm, as before.

Merge radius=1.0mm

The result shows how you can achieve a new
level of quality with merging. As a bonus, you
can save the merged photon map just like any
other photon map.

The conclusion for photons is that they are
useful for distributing energy within a scene.
Even a small number of photons can provide
beneficial overall illumination. However, the
Draft preset for final gather often does the same
job more easily. Photon maps can increase
memory use and lookup time when details are
required.

A better alternative to get details is to combine
photons and final gather.

Next

Photons and Final Gather (page 730)
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Photons and Final Gather

You can combine final gather with photons.
Photons correctly distribute energy into the scene,
using several bounces. Final gather does lookups
into this solution to get an image that has both
details and correct bouncing of light within the
scene.

When combining photons and FG, the good news
is that you don’t need a detailed photon solution:
Final gather generates the local details. It is thus
possible to use a low number of photons. You don’t
have to use 5 million photons and then combine
them with 2,000 FG samples. You can use as few as
5,000-50,000 photons for the overall lighting, and
then add FG rays for the details.

Performance Considerations

Combining FG and photons can give a
performance improvement of around five times
when it replaces final gather multibounce. Five
bounces in FG take roughly five times as long as
one bounce (assuming a room with white walls).
Shooting photons instead can be done in a few
seconds. Whether or not to use photons, then,
depends on:

• Are multiple bounces required? Exterior
rendering, for example, doesn’t need that. Also,
bright rooms with a lot of glass work fine with
a single bounce.

• Do photons work easily with the scene or do
they create photon leaks?

Becoming an Expert

Before combining FG and photons, it’s best
that you gain experience handling photons. In
particular, you need to know how to get a smooth
photon solution. To become an expert on FG and
photons, study these points:

• Final gather “sees” the photon solution.

• First render with FG off, and make sure the
photon solution is smooth. It doesn’t have to be
as smooth as a solution that only uses photons,
but be aware that bright spots, or big jumps
in intensity across an edge, are “seen” by final
gather. When final gather sees an unsmooth
solution, it creates splotches. Increasing final
gather quality cannot solve this. Shooting
10,000 rays at a bright spot will still see a bright
spot.

• Always do the photon test first, and then
add FG. Do not ignore this: It is valuable
information that can save you days of
experimenting.

If you don’t follow this advice, combining photons
and FG can, in particular, create artifacts along
edges.

The following image is from a different scene, not
included in the tutorial, to illustrate the effect. You
can see artifacts along the edge where the left wall
intersects the floor. The scene uses final gather
combined with photons.
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Artifacts along edges

The next image shows the photon solution that’s
responsible for the artifacts.

Unsmooth photon solution

For two of the artifacts we choose a point (red and
green) and show what final gather “sees”: a lot of
bright photons in one case, and a lot of dark wall
in the other. This is the cause of the artifacts.

Always check the photon solution first to insure
that photon intensity is reasonable smooth along
edges. If it isn’t smooth enough, final gather will
see it and maintain the jump no matter how high
you set final gather quality. If you stick to this
formula, you can easily resolve this.

Photons, Ambient Occlusion and Beyond

This possibility is mentioned for completeness. In
most cases combining final gather and ambient
occlusion (AO) gives better results. You can always
use ambient occlusion to add contact shadows to
an overly smooth global illumination image: First
create a smooth photon-based image, using a few
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photons and a large Maximum Sampling Radius
setting. Then use the mental ray Arch & Design
material, and activate ambient occlusion in it.
Details how to add AO are described in the final
gather lesson (page 713).

You can also achieve attractive results quickly by
combining all three methods:

• Photons, for fast overall transport of light
energy

• FG, to smooth the photon solution into
medium-size details

• AO, to bring out small details from the
medium-sized detail

In other words: Let photons handle things
at the meter scale, FG handle things at the
0.1-meter scale, and let AO bring out detail at the
centimeter/millimeter scale. This can create fast,
smooth, yet detailed renderings.

The approach is the same as that described
earlier in this lesson, for photons+FG, except you
intentionally use a lower-density and smoother
FG solution, which renders faster, with AO added
on top.

3dsmax.chm::/arch_design_material_mental_ray.html
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